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ارزیابی کمی تصویر
 Quantitative Assessment

 یتالیدیج تصاویر از استفاده با بعدی سه تصاویر مشخصات گیریاندازه های روش از ای مجموعه
بعدی دو

خروجی های ارزیابی کمی

شمارش تعداد ذرات•

طول هااندازه گیری •

ااندازه گیری کسر حجمی اجز•

3D-visualization of CT volume rendering technique shows the diffuse extent of opacities.

[3] M. Liu, F. Lv, Y. Huang, K. Xiao, Follow-Up Study of the Chest CT Characteristics of

COVID-19 Survivors Seven Months After Recovery, Frontiers in Medicine, 8 (2021).

The microstructure of long crack tip: Shear bands and

secondary cracks between α+β grain boundaries.

[2] Z.W., Xu & Liu, A. & Wang, Xi-Shu. (2019). The influence of building direction on the fatigue crack 

propagation behavior of Ti6Al4V alloy produced by selective laser melting. Materials Science and 

Engineering: A. 767. 138409. 10.1016/j.msea.2019.138409. 

Microstructure of primary Si particles in the TP-1 type solidification samples characterized by optical microscope: 110 
ppm P inoculated Al–22Si–18.8Cu alloys. Different phases are marked in the images
[1] Xu, Yijiang & Deng, Yun & Casari, Daniele & Mathiesen, Ragnvald & Liu, Xiangfa & Li, Yanjun. (2020). Revealing the 
nucleation kinetics of primary Si particles in hypereutectic Al–Si alloys under the influence of P inoculation. Journal of 
Materials Science. 55. 10.1007/s10853-020-05095-3. 
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ImageJ
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@imagejfiji

@imagejfiji

(Kernerl)کرنل ✓

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
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اصلاح 

عکس ها

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
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@imagejfiji
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اصلاح 

عکس ها

Histogram Stretching

•Histogram stretching

:محدودیت

جود فقط زمانیکه نقاط خیلی روشن و یا تاریک و
.نداشته باشد

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
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@imagejfiji

اصلاح 

عکس ها

Histogram Equalizing

•Histogram equalizing

https://t.me/imagejfiji


رنگی کردن تصاویر

مسیر اول* 

آموزش نرم افزار 

ImageJ
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@imagejfiji

Image < lookup tables

مسیر دوم* 

https://t.me/imagejfiji


اصلاح اولیه 

عکس ها

آموزش نرم افزار 

ImageJ
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•Erode

•Dilate

https://t.me/imagejfiji


اصلاح اولیه 

عکس ها

آموزش نرم افزار 

ImageJ
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•Open

•Close

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
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@imagejfiji

محاسبه درصد 

تخلخل
محاسبه درصد تخلخل✓

ASTM B276استاندارد

ASTM B276استاندارد 

https://t.me/imagejfiji
file:///D:/Classes/ImageJ/Standards/ASTM-B276-05(reapproved 2015).pdf
ImageJ Files/ImageJ/Standards/ASTM-B276-05(reapproved 2015).pdf
ImageJ Files/ImageJ/Standards/ASTM-B276-05(reapproved 2015).pdf
ImageJ Files/ImageJ/Standards/ASTM-B276-05(reapproved 2015).pdf


آموزش نرم افزار 

ImageJ
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@imagejfiji
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محاسبه درصد 

تخلخل
محاسبه درصد تخلخل در ذرات انتخابی✓

(فقط ذرات گوشه دار کاربید مدنظر ما هست)

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
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محاسبه درصد 

تخلخل
محاسبه درصد تخلخل در ذرات انتخابی✓

F2 * 100

D2/E2

yو xحاصلضرب

تصویر

ImageJدر بالای 
=Sum (B:B)

https://t.me/imagejfiji


آموزش نرم افزار 
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بررسی ساختار 

کامپوزیت ها
بررسی ساختار کامپوزیت ها✓

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
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بررسی ساختار کامپوزیت ها✓

بررسی ساختار 

کامپوزیت ها

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
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بررسی ساختار 

کامپوزیت ها
Area - Area of selection in square pixels. Area is in calibrated units, such as square millimeters, if Analyze>Set 

Scale was used to spatially calibrate the image.

Mean Gray Value - Average gray value within the selection. This is the sum of the gray values of all the pixels in the 

selection divided by the number of pixels. Reported in calibrated units (e.g., optical density) if Analyze>Calibrate was 

used to calibrate the image. For RGB images, the mean is calulated by converting each pixel to grayscale using the 

formula gray=0.299red+0.587green+0.114blue or the formula gray=(red+green+blue)/3 if "Unweighted RGB to 

Grayscale Conversion" is checked in Edit>Options>Conversions.

Standard Deviation - Standard deviation of the gray values used to generate the mean gray value.

Modal Gray Value - Most frequently occurring gray value within the selection. Corresponds to the highest peak in the 

histogram.

Min & Max Gray Level - Minimum and maximum gray values within the selection.

Centroid - The center point of the selection. This is the average of the x and y coordinates of all of the pixels in the 

image or selection. Uses the X and Y Results table headings.

Center of Mass - This is the brightness-weighted average of the x and y coordinates all pixels in the image or selection. 

Uses the XM and YM headings. These coordinates are the first order spatial moments.

Perimeter - The length of the outside boundary of the selection.

Bounding Rectangle - The smallest rectangle enclosing the selection. Uses the headings BX, BY, Width and Height, 

where BX and BY are the coordinates of the upper left corner of the rectangle.

Fit Ellipse - Fit an ellipse to the selection. Uses the headings Major, Minor and Angle. Major and Minor are the primary 

and seconday axis of the best fitting ellipse. Angle (0-180 degrees) is the angle between the primary axis and a line 

parallel to the x-axis of the image. The coordinates of the center of the ellipse are displayed as X and Y if Centroid is 

checked. Note that ImageJ cannot calculate the major and minor axis lengths if Pixel Aspect Ratio in the Set 

Scale dialog is not 1.0.

There are several ways to view the ellipse. The Edit>Selection>Fit Ellipse command replaces an area selection with the 

best fit ellipse. The DrawEllipse macro draws (destructively) the best fit ellipse and the major and minor axis. Select 

"Ellipses" from the Show: drop down menu in the particle analyzer and it will draw the ellipse for each particle in a 

separate window.

Shape Descriptors (previously Circularity) - Calculate and display the following shape descriptors

Feret's Diameter - The longest distance between any two points along the selection boundary, also known as maximum 

caliper. Uses the Feret heading. FeretAngle (0-180 degrees) is the angle between the Feret's diameter and a line parallel 

to the x-axis of the image. MinFeret is the minimum caliper diameter. The starting coordinates of the Feret's diameter 

(FeretX and FeretY) are also displayed. The DrawFeretDiameter macro draws the Feret's diameter of the current 

selection.

Integrated Density - Calculates and displays two values: "IntDen" (the product ofArea and Mean Gray Value) and "RawIntDen" 

(the sum of the values of the pixels in the image or selection). "RawIntDen" is only available in ImageJ 1.44c or later. "IntDen" 

and "RawIntDen" values are the same for uncalibrated image. The Dot Blot Analysis example demonstrates how to use this 

option to analyze a dot blot assay.

Median - The median value of the pixels in the image or selection.

Skewness - The third order moment about the mean. The documentation for the Moment Calculator plugin explains how to 

interpret spatial moments.

Kurtosis - The fourth order moment about the mean.

Area Fraction - The percentage of pixels in the image or selection that have been highlighted in red 

using Image>Adjust>Threshold. For non-thresholded images, the percentage of non-zero pixels.

Stack Position - The current position (channel, slice and frame) in the stack or hyperstack. Uses the headings "Ch", "Slice" and 

"Frame".

Limit to Threshold - If checked, only thresholded pixels are included in measurement calculations. 

Use Image>Adjust>Threshold to set the threshold limits.

Display Label - If checked, the image name and slice number (for stacks) are recoded in the first column of the results table.

Invert Y Coordinates - If checked, the XY origin is assumed to be the lower left corner of the image window instead of the upper 

left corner.

Redirect To - The image selected from this popup menu will be used as the target for statistical calculations done by 

the Measure and Analyze Particles commands. The Redirect To feature allows you to outline a structure on one image and 

measure the intensity of the corresponding region in another image. With ImageJ 1.35d or later this feature also works with 

stacks. Note that it is the thresholding of the target image that is used when Limit to Threshold is enabled.

Decimal Places - This is the number of digits to the right of the decimal point in real numbers displayed in the results table and 

in histogram windows.

Set Measurements instruction Imagej.net

Set Measurements instruction Imagej.net

https://t.me/imagejfiji
https://imagej.net/ij/macros/DrawEllipse.txt
https://imagej.net/ij/macros/DrawFeretDiameter.txt
https://imagej.net/ij/docs/examples/dot-blot/
https://imagej.net/ij/plugins/moments.html
https://imagej.net/ij/docs/menus/analyze.html


آموزش نرم افزار 

ImageJ
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رسم هیستوگرام و بررسی 

نانوذرات

WatershedThreshold

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
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رسم هیستوگرام و بررسی 

نانوذرات

https://t.me/imagejfiji


آموزش نرم افزار 
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دایره مساحت = 𝜋𝑟2                               2r = D

𝑆 = 𝜋
𝐷

2

2

⇒ 𝑆 = 𝜋
𝐷2

22 ⇒ 𝑆 = 𝜋
𝐷2

4

4𝑆 = 𝜋𝐷2  ⟶
4𝑆

𝜋
= 𝐷2 ⟶

4𝑆

𝜋
= 𝐷

ریشه دوم

رسم هیستوگرام و بررسی 

نانوذرات

https://t.me/imagejfiji


آموزش نرم افزار 
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رسم هیستوگرام و بررسی 

نانوذرات

https://t.me/imagejfiji


ندازها محاسبه عدد  

دانه
مفهوم عدد اندازه دانه✓

روش هاي محاسبه عدد اندازه دانه✓

(Intercept)روش خطوط موازی •

(Planimetric)روش مساحت سنجی و مساحت میانگین •

روش مقایسه ای•

آموزش نرم افزار 

ImageJ
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@imagejfiji

@imagejfiji

https://t.me/imagejfiji


ندازها محاسبه عدد  

دانه
یا بیضویدایره ایحالت : شکل اول•

خارج شدهدایره ایکه تقریبا از حالت دانه هایی: شکل دوم•

خارج شده دایره ایکه کاملا از حالت دانه هایی: شکل سوم•

آموزش نرم افزار 

ImageJ
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𝑓1 =
𝑏

𝑎
𝑓2 =

4𝜋𝐴

𝐿2

𝑓3 =
𝑑1

𝑑2

https://t.me/imagejfiji


محاسبه عدد اندازه دانه

(Comparison method)مقایسه ای : روش اول✓

دانه ها ریزتر: 8به 1هرچه از 

آموزش نرم افزار 

ImageJ
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𝑁 = 2𝐺−1

𝐺 =
log 𝑛

log 2
+ 1

𝐷 =
4𝐴

𝜋

شماره اندازه دانه 

(G )ASTM

تعداد دانه در 

(Z)100بزرگنمایی 

تعداد دانه در 

𝑚𝑚2هر 
(𝑢𝑚2)سطح دانه 

111662000

223231000

346415600

481287800

5162563900

6325121950

7641024980

81282048490

https://t.me/imagejfiji


محاسبه عدد اندازه دانه

روش خطوط موازی✓

معیار ریز بودن دانه ها

ASTM E112-13تعریف براساس استاندارد     

ሚl =
خطوط طول

شده قطع های مرزدانه تعداد میانگین

نحوه محاسبه تعداد مرزدانه های قطع شده

آموزش نرم افزار 

ImageJ
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ImageJ Files/ImageJ/Standards/ASTM-E112-13.pdf
ImageJ Files/ImageJ/Standards/ASTM-E112-13.pdf
ImageJ Files/ImageJ/Standards/ASTM-E112-13.pdf
ImageJ Files/ImageJ/Standards/ASTM-E112-13.pdf
https://t.me/imagejfiji


محاسبه عدد اندازه دانه

ሚlروش خطوط موازی✓ =
خطوط طول

شده قطع های مرزدانه تعداد میانگین

ሚl =
145.99

15 + 19 + 15 + 13 + 13 + 14 + 16 + 16 + 15 + 14 + 13 + 10 + 11 + 13 + 13 + 12
16

=
145.99

13.875
= 10.52 𝜇𝑚 = 10.52 ∗ 10−3𝑚𝑚 

𝐺 = ൫−6.643856 ∗ log ൯ሚ𝑙 − 3.288 ሚ𝑙 𝑖𝑛 𝑚𝑚

براساس 
استاندارد

𝐺 = ቀ−6.643856 ∗ log ൯10.52 ∗ 10−3 − 3.288 = 9.85 ⟶ 𝐺 ≈ 10

آموزش نرم افزار 

ImageJ
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https://t.me/imagejfiji


محاسبه عدد اندازه دانه

روش خطوط موازی✓

آموزش نرم افزار 

ImageJ
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https://t.me/imagejfiji


محاسبه عدد اندازه دانه

روش مساحت سنجی✓

آموزش نرم افزار 

ImageJ
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ሚ𝐴 =
1

𝑁𝐴

ሚ𝑑 = ሚ𝐴 

𝐺 = ቀ3.321928 ∗ log ൯𝑁𝐴 − 2.95

ሚ𝐴مساحت متوسط دانه ها

ሚ𝑑  قطر متوسط دانه ها

෩𝑁𝑎تعداد دانه در مساحت یک میلی متر مربع

https://t.me/imagejfiji


محاسبه عدد اندازه دانه

روش مساحت سنجی✓

آموزش نرم افزار 

ImageJ
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∗ 10−6

معکوس مساحت 

میانگین در یک میلی 

متر مربع
(3.322 ∗ log 𝑁𝐴) − 2.95

*

https://t.me/imagejfiji


محاسبه عدد اندازه دانه

روش مساحت سنجی✓

آموزش نرم افزار 

ImageJ
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*

https://t.me/imagejfiji


بررسی گرافیت ها در 

چدن ASTM A247-17براساس استاندارد ✓

(ظاهری)انواع گرافیت ها ✓

آموزش نرم افزار 

ImageJ
59

@imagejfiji

@imagejfiji

ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
https://t.me/imagejfiji


بررسی گرافیت ها در 

چدن ASTM A247-17براساس استاندارد ✓

لایه ایگرافیت هایانواع ✓

آموزش نرم افزار 

ImageJ
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ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
https://t.me/imagejfiji


بررسی گرافیت ها در 

چدن ASTM A247-17براساس استاندارد ✓

(سایز)انواع گرافیت ها ✓

آموزش نرم افزار 

ImageJ
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ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
https://t.me/imagejfiji


بررسی گرافیت ها در 

چدن ASTM A247-17براساس استاندارد ✓

انواع گرافیت ها✓

آموزش نرم افزار 

ImageJ
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ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
https://t.me/imagejfiji


بررسی گرافیت ها در 

چدن ASTM A247-17براساس استاندارد ✓

(Nodularityتاثیر )انواع گرافیت ها ✓

آموزش نرم افزار 

ImageJ
63

@imagejfiji

@imagejfiji

Nodule Count of 100 % Nodularity Ductile Iron (*100)

ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
https://t.me/imagejfiji


بررسی گرافیت ها در 

چدن ASTM A247-17براساس استاندارد ✓

(Nodularityتاثیر )انواع گرافیت ها ✓

آموزش نرم افزار 

ImageJ
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Nodule Count of 90 % Nodularity Ductile Iron (*100)

VIID3
70%VIID3.30%VIIA4

ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
https://t.me/imagejfiji


بررسی گرافیت ها در 

چدن ASTM A247-17براساس استاندارد ✓

انواع گرافیت ها✓

میلی متر مربع چند ذره؟1در 

آموزش نرم افزار 

ImageJ
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ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
https://t.me/imagejfiji


محاسبه میزان کرویت 

گرافیت ها  ASM handbook Volو کتابASTM247-17براساس استاندارد ✓

1&9

آموزش نرم افزار 

ImageJ
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𝑁𝑜𝑑𝑢𝑙𝑎𝑟𝑖𝑡𝑦 =
𝑡𝑦𝑝𝑒 𝐼 + 𝑡𝑦𝑝𝑒 𝐼𝐼

𝑡𝑦𝑝𝑒 𝐼 + 𝑡𝑦𝑝𝑒 𝐼𝐼 + 𝑡𝑦𝑝𝑒 𝐼𝐼𝐼 + 𝑡𝑦𝑝𝑒𝐼𝑉

ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.1 Irons Steels and High Performance Alloys.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.1 Irons Steels and High Performance Alloys.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.9 Metallography and Microstructures.pdf
https://t.me/imagejfiji


محاسبه میزان کرویت 

گرافیت ها  ASM handbook Volو کتابASTM247-17براساس استاندارد ✓

1&9

آموزش نرم افزار 
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ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/Standards/ASTM A247-17.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.1 Irons Steels and High Performance Alloys.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.1 Irons Steels and High Performance Alloys.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.9 Metallography and Microstructures.pdf
https://t.me/imagejfiji


پلاگین ها و زاویه 

آغشتگی Shape Analysisو Contact angleپلاگین های✓

افزودن پلاگین ها✓

محاسبه زاویه آغشتگی✓

آموزش نرم افزار 

ImageJ
68

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


پلاگین ها و زاویه 

آغشتگی افزودن پلاگین ها✓

Contact angleپلاگین•

محاسبه زاویه آغشتگی✓

آموزش نرم افزار 

ImageJ
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https://t.me/imagejfiji
https://imagej.net/ij/plugins/download/jars/Contact_Angle.jar


پلاگین ها و زاویه 

آغشتگی محاسبه زاویه آغشتگی✓

آموزش نرم افزار 

ImageJ
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https://t.me/imagejfiji


پلاگین ها و زاویه 

آغشتگی محاسبه زاویه آغشتگی✓

آموزش نرم افزار 

ImageJ
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180 − 𝜃 ها قابل استفاده اند𝜃هرکدام از 

https://t.me/imagejfiji


پلاگین ها و زاویه 

آغشتگی افزودن پلاگین ها✓

 Shape Analysisپلاگین•

محاسبه زاویه آغشتگی•

LB-ADSA: روش اول•

DropSnake: روش دوم•

آموزش نرم افزار 

ImageJ
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https://t.me/imagejfiji
https://bigwww.epfl.ch/demo/dropanalysis/


پلاگین ها و زاویه 

آغشتگی -LBمحاسبه زاویه آغشتگی به روش ✓

ADSA

آموزش نرم افزار 

ImageJ
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https://t.me/imagejfiji


پلاگین ها و زاویه 

آغشتگی محاسبه زاویه آغشتگی به روش ✓

DropSnake

آموزش نرم افزار 

ImageJ
74

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


محاسبه درصد کاهش سطح 

مقطع تست کشش✓

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

مواد نرممواد ترد

𝑟0

𝑟𝑓

75

𝑟 =
𝐴0 − 𝐴𝑓

𝐴0

ℯ =
1

1 − 𝑟

𝜀 = ln
1

1 − 𝑟

کرنش 
کاهش حقیقی

سطح

کرنش 
مهندسی

https://t.me/imagejfiji


محاسبه درصد کاهش سطح 

مقطع تست کشش✓

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji
76

𝑟0

𝑟𝑓

https://t.me/imagejfiji


محاسبه درصد کاهش سطح 

مقطع تست کشش✓

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji
77

𝑟𝑓 :1575.17مقدار 

𝑟0 :5100.42مقدار 

𝜋
1.575172

4
= 1.948

𝜋
5.1002

4
= 20.42

𝐴0 − 𝐴𝑓

𝐴0
= 0.904

∗100
90%

https://t.me/imagejfiji


  محاسبه فاصله بین صفحات در

HRTEM 

آموزش نرم افزار 

ImageJ
78

@imagejfiji

@imagejfiji

FFT

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
79

@imagejfiji

@imagejfiji

B&C

  محاسبه فاصله بین صفحات در

HRTEM 

https://t.me/imagejfiji


آموزش نرم افزار 

ImageJ
80

@imagejfiji

@imagejfiji

3.34

12
= 0.278 nm (d spacing)مقدار فاصله بین دو صفحه 

  محاسبه فاصله بین صفحات در

HRTEM 

https://t.me/imagejfiji


در تصاویر hklتعیین اندیس صفحات 
TEM

آموزش نرم افزار 

ImageJ
81

@imagejfiji

@imagejfiji

SAEDدر تصاویر d-spacingمحاسبه ✓

hklتعیین اندیس صفحات ✓

https://t.me/imagejfiji


در تصاویر hklتعیین اندیس صفحات 
TEM

آموزش نرم افزار 

ImageJ
82

@imagejfiji

@imagejfiji

SAEDدر تصاویر d-spacingمحاسبه •

https://t.me/imagejfiji


در تصاویر hklتعیین اندیس صفحات 
TEM

آموزش نرم افزار 

ImageJ
83

@imagejfiji

@imagejfiji

SAEDدر تصاویر d-spacingمحاسبه •

Fit elipse , Display label ,Add to overlay

Analyzing SAED Pattern

1/2r (nm^-1) 1/r (nm^-1) r (nm) d-Spacing A֯

https://t.me/imagejfiji


در تصاویر hklتعیین اندیس صفحات 
TEM

آموزش نرم افزار 

ImageJ
84

@imagejfiji

@imagejfiji

SAEDدر تصاویر d-spacingمحاسبه •

Analyzing SAED Pattern

1/2r (nm^-1) 1/r (nm^-1) r (nm) d-Spacing A֯

/2 *10

https://t.me/imagejfiji


در تصاویر hklتعیین اندیس صفحات 
TEM

آموزش نرم افزار 

ImageJ
85

@imagejfiji

@imagejfiji

SAEDدر تصاویر d-spacingمحاسبه •

https://t.me/imagejfiji


ه تبدیل تصاویر دوبعدی به نمودارهای س

بعدی

آموزش نرم افزار 

ImageJ
86

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


ه تبدیل تصاویر دوبعدی به نمودارهای س

بعدی

آموزش نرم افزار 

ImageJ
87

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


ه تبدیل تصاویر دوبعدی به نمودارهای س

بعدی

آموزش نرم افزار 

ImageJ
88

@imagejfiji

@imagejfiji

 Interactive 3D Surface plotافزودن پلاگین  ✓

https://t.me/imagejfiji
https://imagej.net/ij/plugins/surface-plot-3d.html


ای تعیین کمیت نواره

ژل

آموزش نرم افزار 

ImageJ
89

@imagejfiji

@imagejfiji

Invert LUT: تغییر طیف رنگی ✓

https://t.me/imagejfiji


ای تعیین کمیت نواره

ژل

آموزش نرم افزار 

ImageJ
90

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


ای تعیین کمیت نواره

ژل

آموزش نرم افزار 

ImageJ
91

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


بخش بندی تصاویر

رنگی

آموزش نرم افزار 

ImageJ
92

@imagejfiji

@imagejfiji

کاربردها✓

Trainable Weka Segmentationپلاگین✓

https://t.me/imagejfiji


بخش بندی تصاویر

رنگی

آموزش نرم افزار 

ImageJ
93

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


بخش بندی تصاویر

رنگی

آموزش نرم افزار 

ImageJ
94

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


بخش بندی تصاویر

رنگی

آموزش نرم افزار 

ImageJ
95

@imagejfiji

@imagejfiji

https://t.me/imagejfiji


ز   محاسبه میکروسختی ویکر

و   نوپ

آموزش نرم افزار 

ImageJ
96

@imagejfiji

@imagejfiji

 ASM Handbookو کتاب ASTM E384استاندارد ✓

Vol8

نوپو ویکرز، برینل، راکول: دارای انواع مختلف ✓

:روش انجام آزمایش✓

دایر

ه

هرم

هرم

هرم/ دایره 

https://t.me/imagejfiji
ImageJ Files/ImageJ/Standards/ASTM E384-05.pdf
ImageJ Files/ImageJ/Standards/ASTM E384-05.pdf
ImageJ Files/ImageJ/Standards/ASTM E384-05.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.8 Mechanical Testing and Evaluation.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.8 Mechanical Testing and Evaluation.pdf
ImageJ Files/ImageJ/ASM Handbooks/Vol.8 Mechanical Testing and Evaluation.pdf


ز   محاسبه میکروسختی ویکر

و   نوپ

آموزش نرم افزار 

ImageJ
97

@imagejfiji

@imagejfiji

محاسبه میکروسختی ✓

𝐻𝑉"ویکرز" = 1.8544
𝐹

𝑑2

https://t.me/imagejfiji


ز   محاسبه میکروسختی ویکر

و   نوپ

آموزش نرم افزار 

ImageJ
98

@imagejfiji

@imagejfiji

("Knoop)نوپ "محاسبه میکروسختی ✓

𝐻𝐾 = 14.229
𝐹

𝑑2

https://t.me/imagejfiji


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ
99

@imagejfiji

@imagejfiji

HAZمفهوم ✓

https://t.me/imagejfiji


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ
100

@imagejfiji

@imagejfiji

HAZمحاسبه ✓

https://t.me/imagejfiji


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

محاسبه ارتفاع گرده جوش✓

101

https://t.me/imagejfiji


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

محاسبه ارتفاع گرده جوش✓

102

https://t.me/imagejfiji


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

✓DAS وSDAS

DAS: دندریتفاصله بین بازوهای

SDAS : ثانویهدندریتفاصله بین بازوهای

Chill–( هم محور ریز)ناحیه اول 

ودندریتیرشد )دندریتی–ناحیه ستونی 

(سلولی

ناحیه هم محور تشکیل شده در مرکز قطعه

103
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 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

✓DAS وSDAS

DAS: دندریتفاصله بین بازوهای

SDAS : ثانویهدندریتفاصله بین بازوهای

104

https://t.me/imagejfiji


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

✓DAS وSDAS

DAS: دندریتفاصله بین بازوهای

SDAS : ثانویهدندریتفاصله بین بازوهای

105

https://t.me/imagejfiji


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

(منبع)SDASو DASمحاسبه✓

106

https://t.me/imagejfiji
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

(منبع)SDASو DASمحاسبه✓

ثانویه در کمترین طرفدندریت هایتقسیم بر تعداد دندریتطول کل : Aروش•

ثانویه در بیشترین طرفدندریت هایاما تقسیم بر تعداد Aهمانند : Bروش •

ثانویه در دو طرفدندریت هایتقسیم بر تعداد دندریتطول کل : Cروش •

𝑆𝐷𝐴𝑆 =
𝐿

𝑁 − 1

𝑆𝐷𝐴𝑆 =
2𝐿

𝑁 − 2
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https://t.me/imagejfiji
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

(منبع)SDASو DASمحاسبه✓

یم بر تعداد ثانویه تقسدندریتثانویه تا اخرین دندریتبرابر با مرکز اولین Lطول : Dروش•

در یکی از طرفین 

ثانویهدندریت هایمحاسبه فاصله بازو به بازوی : دقیق ترین روش: Eروش •

Dو Eروش هاینزدیکی نتایج در 

108

https://t.me/imagejfiji
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf


 ,HAZ, DASمحاسبه 

SDAS

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

(منبع)SDASو DASمحاسبه✓
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https://t.me/imagejfiji
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf
ImageJ Files/ImageJ/Standards/Papers/Comparison of Measurement Methods for Secondary Dendrite.pdf


محاسبات 

خوردگی

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

(MPY / CPR)نحوه گزارش خوردگی یکنواخت 

:پارامترهای گزارش خوردگی با توجه به تصاویر

میزان تغییرات ضخامت•

زمان ایجاد تغییرات•

نمونه شما دچار خوردگی شده است،269𝜇𝑚ماه، 1برای مثال در طی 

.گزارش نماییدMPYنرخ خوردگی را برحسب 

110
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محاسبات 

خوردگی

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

(MPY)نحوه گزارش خوردگی یکنواخت 

296
𝜇𝑚

1𝑚𝑜𝑛𝑡ℎ
∗

12 𝑚𝑜𝑛𝑡ℎ 

1𝑦𝑒𝑎𝑟
∗

1𝑚𝑚

1000 𝜇𝑚
∗

1 𝑖𝑛𝑐ℎ

25.4 𝑚𝑚
∗

1 𝑚𝑖𝑙

0.01 𝑖𝑛𝑐ℎ
=

296
𝜇𝑚

30𝑑𝑎𝑦
∗

365 𝑑𝑎𝑦

1𝑦𝑒𝑎𝑟
∗

1𝑚𝑚

1000 𝜇𝑚
∗

1 𝑖𝑛𝑐ℎ

25.4 𝑚𝑚
∗

1 𝑚𝑖𝑙

0.01 𝑖𝑛𝑐ℎ
=
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محاسبات 

خوردگی

آموزش نرم افزار 

ImageJ

@imagejfiji

@imagejfiji

(MPY)نحوه گزارش خوردگی یکنواخت 

296
𝜇𝑚

30𝑑𝑎𝑦
∗

365 𝑑𝑎𝑦

1𝑦𝑒𝑎𝑟
∗

1𝑚𝑚

1000 𝜇𝑚
∗

1 𝑖𝑛𝑐ℎ

25.4 𝑚𝑚
∗

1 𝑚𝑖𝑙

0.01 𝑖𝑛𝑐ℎ
= 14.17 𝑀𝑃𝑌

296
𝜇𝑚

1𝑚𝑜𝑛𝑡ℎ
∗

12 𝑚𝑜𝑛𝑡ℎ 

1𝑦𝑒𝑎𝑟
∗

1𝑚𝑚

1000 𝜇𝑚
∗

1 𝑖𝑛𝑐ℎ

25.4 𝑚𝑚
∗

1 𝑚𝑖𝑙

0.01 𝑖𝑛𝑐ℎ
= 127.086 𝑀𝑃𝑌 

ه اول دلیل تفاوت در نتایج به علت دقت در تعداد روزها در رابط! 

است

112
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